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Chapter 1

Introduction

For 30 years, China Nuclear Data Center (CNDC) has been accumulating neutron

and charged particles induced reaction data as EXchange FORmat (EXFOR) data

files.

The evaluators and experimenters always desire to have full and latest experimental

data sets. However, the data are often published as figures without numerical values for

some publications or journals. Furthermore, the quality of figures is not always good

enough, especially for some figures scanned from the hard copy of old publications. In

the other hand, the researchers would like to retrieve the data directly from EXFOR

database. Digitization of figures is only one method to obtain the numerical data

and correlative uncertainty, when there are only figures available from publications.

Therefore a digitization software was developed to fit the requirements from evaluation,

measurement and EXFOR compilation in CNDC.

Before 2000, there was no common software to digitize experimental and evaluated

data. And the quality of digitization results can not fit the requirements of evaluation

and measurement using the traditional coordinate paper (plotting paper) or rule. The

end of twenty century, the personal computer was developed so quickly that to develop

a software for digitization purpose become possible. Since 1997, CNDC devotes to

develop a software for digitization. The first version of digitization software GDGraph

was developed and released in 2000 using VC++ language. Although, the functions of

the 1st version of GDGraph is fit the basic requirements of digitization only, in which

can digitize one group data excluding data error, BMP image format only, and it can
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not randomly delete digitizing points. However, the mold of GDGraph software can

obtain higher quality digitizing results and high efficiency than the traditional way.

Five years late, collected much feedback information on update and bugs of this

software. The 2nd version of GDGraph software was released at 2006, in which the

whole software was re-written using Perl computer language to obtain more comfort-

able conditions for programming and updating. The version 3.0, 4.0, 5.0 and 5.1 of

GDGraph is released at 2011, 2012, 2013 and 2016, respectively.

The software GDGraph5.1, described in this paper is used for reading the numerical

data from an image file. Main features of GDGraph5.1 is listed below:

• Operating system: WindowsXP or Windows higher versions OS.

• Intuitive and light GUI: Provide Chinese and English version GUI. The GUI type

is changed from “Dialogue” to SDI (Single document interface).

• Supports image format: such as PNG, GIF, BMP and JPEG etc.

• The image can be automatically fit to the GUI window according to your screen

resolution, and zoom-in or zoom-out manually together with the digitizing X, Y

axis.

• Allow to rotate the image and set a rotation angle with degree unit. So the

digitizing axis can fit well with the image one.

• The image size is reverted to the original one, if it was been zoom-in or zoom-out.

• The maximum digitizing data group number is three, and the color, size and

shape of each group can be defined by user using “Settings” function.

• Randomly add the digitizing point and move it by mouse or cursor keys.

• Output data can be saved as a data file or at clipboard. And the digit number

of output data can be defined by user. And two output data column order is

available.

• Import data function is enable to reuse the former digitizing data or compare

with other data group easily.

• X, Y axes: Select or set a unit for X, Y data by user is available for identification

the contents of each column. Using “Tab” to active axes setting value.
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• Allow to digitize X, Y error with symmetry or asymmetry mode and move it

using mouse or cursor keys, and set a fix value as X, Y error with relative (%, in

percent) or absolute mode.

• Load an image by menu or directly paste from clipboard, which doesn’t reset the

original setting condition.

• A new function is available for loading an image and resetting the original setting

condition.

• Allow to select thin or thick line for axis, data point symbol and error bar etc.

• Magnifying glass function: It magnify the local area of the image, and the window

size can be set from 100% to 800% and move it by mouse. The partial image in

the magnifying glass window can be magnified 2 or 4 times.

• Setting the color, size and shape of data point, the background with or with-

out gridding lines and its distance, output digitizing numerical data format is

available.

• Project function is used to save image, digitizing results, axes together with other

settings for checking, correction, modification in the future. The default extension

file name is “gdp”.

• Remark function is applied to keep some marks and memo text for checking,

modification and memory by user.

• Using shortcut key to select the active point by “PageUp” or “PageDown” as

previous or next point.

• Zoom in/out for Axes point area and setting the axes line color is available.

This document describes how to use the numerical data reading software, GDGraph5.1[1]

released in Oct., 2016. The contents of this document are shown as follows: Chapter 2

gives the basic usage of GDGraph5.1, such as starting-up and reading the numerical

data from the graphical data. Chapter 3 describes the more sophisticated functions,

such as, setting function, import data function, magnifying glass function and project

function. Section 4.1 gives how to customize GDGraph5.1. Section 4.2 describes the

output data format treated in GDGraph5.1. Keyboard Shortcuts and the changes from

last version of GDGraph are described in the Section 4.3 and 4.4.
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IMPORTANT: PLEASE USE THIS SYSTEM AT YOUR OWN RISK.

IT IS NOT ALLOWED TO USE THIS SYSTEM FOR ANY KIND OF

BUSINESS PURPOSE.
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Chapter 2

How to use GDGraph

2.1 Installing GDGraph

Recently GDGraph can be used in WINDOWS operation system only such as

WindowsXP or Windows higher version OS. To download the installation file “GD-

Graph5.1.msi” from the website as http://www.nuclear.nsdc.cn/gdgraph.

Figure 2.1 The interface of starting installation for GDGraph

5
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Now you can double clicks “GDGraph5.1.msi” file to start install GDGraph in

your computer, the interface of installation is shown in Figure 2.1. Click “Next”

button to continue install. The “Custom” mode of installation allows to choose the

installation directory, and the “Install” mode use the default installation directory as

“C:\Program Files\CNDC\GDGraph\”. You can find the short cut execution link at

Windows start program menu as “CNDC” or you can have a shortcut link at desktop.

Now you are ready to start and use GDGraph.

Note: We do not recommend to install GDGraph at system partition (usually

name as “C:”) in Windows7. Otherwise, you can not allow to load the sample files

such as project file, numerical data file for testing import function from system partition

without administrator privileges. In other hand, you can use Windows7 start menu

“run as administrator” to start GDGraph, then load the sample files from system

partition.

2.2 Starting-up the system

Let’s start software by double-clicking the “GDGraph” at desktop. When GDGraph

starts, you would see the window shown in Figure 2.2.

The window of GDGraph contains four main components: menu bar, control panel,

navigation bar and main panel. Menu bar provides menus to operate GDGraph and set

some optional parameters. Control panel contains functions required to read data, such

as setting data group, axe mode, fix value of X Y error and its modes, image rotation

angle, adding new data point, magnifying glass function, shortcut setting parameters

and operation error bar etc. Navigation bar contains buttons to magnify the image,

rotate image according to the setting angle value, fit the image size to the main panel

and show the image with original size. An image loaded from a file is displayed on the

main panel. The digitizing data is on this panel.

GDGraph can be operated using a keyboard, but in this document, how to operate

the menu bar and the control panel by a mouse is explained in detail. Keyboard

shortcuts are shown in Table 4.1 at Appendix 4.3.
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Figure 2.2 Starting-up window of GDGraph. You can select “Load Graph File” or

“Load Project File” in “File” menu to load a image file or project file. “Settings”

function in the “Edit” menu or “Control Panel”.

2.3 Loading the image file

You have some options to load an image file. One is using “Load Image File0 or

“Load Image File Reset” from the “File” menu in the menu bar without or with reset

the original setting condition. Select an image file (such as PNG, GIF, BMP or JPEG)

from a file dialog box in a new window and the image with original size is default.

Another one can directly copy an image using clipboard from other file such as MS

Word, PDF, etc. If the image file is successfully loaded, the image is displayed on the

main panel as shown in Figure 2.3. The sample image used in this document was made

from experimental data in Fig 3 of Nucl. Instrum. Methods Phys. Res. B 269 (2011)

2032.
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Figure 2.3 Window after an image loaded. The image is displayed on the main panel

with original size.

To enlarge the size of the main panel, please maximize the window of GDGraph.

The main panel expands and shrinks automatically to fit the size of GDGraph window.

If you want to zoom in and out the image, please use the “Zoom in” or “Zoom out”

button at “Navigation Bar”. To fit the image size with the main panel, use the “Fit

Size” button at “Navigation Bar”. Use the “Real Size” button at “Navigation Bar”

to revert the image to original size. You can also magnify partially area using “Zoom

Window” function at “Control Panel”.

2.4 Setting axes

Use cross lines to set the X-Y axes of image, and adjust the square symbols of the

starting, middle and ending positions of X-Y axes to fit the image one. Then select

the X-Y axes type as Linear-Linear, Linear-Log, Log-Linear and Log-Log. According

to the cross line positions, fill in the starting and ending value of X-Y axes, and select

or fill in unit for X-Y axes at “Coordinate System” in “Control Panel”, respectively.

“Tab” key is assist to fill in the X-Y axes value setting.

In GDGraph5.1 version, the axis point could be activated or deactivated one by
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Figure 2.4 Window after setting axes. There exist squares on the axes to pull it to

proper position.

Figure 2.5 Activated or deactivated axis point by “Ctrl+x”, and using maginfying

glass funciton to zoom-in axis point.

one using “Ctrl+x” or “Edit” at menu bar. Using magnifying glass function as clicking

“Zoom Window” to realize zoom-in axis point for digitizing XY axis in high quality,

which is shown in Figure 2.5. It is allowed to move the axis point to a proper position

by mouse or cursor keys. And the X-Y axes line color could be set using “Axis Color”
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in “Edit” menu bar to obtain high contract with the image.

If you want to move the starting or ending position of one axis to proper position

by mouse or cursor keys. If you want to move whole axis line, pull the middle point

between starting and ending point to proper position. When we set or adjust the

positions of axis, there exist an orthogonal cross lines to assist confirming the position

of axes. When you finish setting the axes, you will see a window shown in Figure 2.4.

Note: Sometimes the image is not right rectangle, please use the rotation function

at “Navigation Bar” to adjust it before starting to set the axes.

2.5 Reading the data

Figure 2.6 Window after reading the data points. The cross lines is help user to

confirm the position of data point.

You are ready to read data if you finish setting the axes. Activate the check box

“Add points” at “Control Panel” to enter the data input mode. If there have existed

more than one group digitizing data, please select which group you want to add new

points or modify the original digitizing results. If you click on the image in the data

input mode, a data point is added on the image, which is default with blue in color and
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circle in shape for the 1st group data points. You can add another point by clicking

another place. Continue to click the image until all the data points are added or pull

the error bar after reading a data point. This mode is canceled by clicking the “Add

points” check box again. When you finish adding the data points, you will see a window

as shown in Figure 2.6. If you modify or remove the data, please refer to Section 2.7

(“Modifying and removing the data”).

You can configure the shape, size and color of different digitizing group data point

using “Settings” function, please refer to Appendix 4.1.

2.6 Reading the error information

This section gives how to read error information. First of all, disable the “Add

points” mode by taking out the “
√

” at “Add points” check box. Then, please select

the error mode of X-Y with asymmetric or symmetric. The default error mode of X-Y

is asymmetric. To set a symmetric error for X or Y, first select X-axis or Y-axis at

“Axis” list box in “Errors” part at “Control panel”, then click “Symmetric” check box.

After that, click a data point to activate it which will appear 4 red square symbols

around it. In this mode, it allows to move data point by mouse or cursor keys or

set X-Y error. The left and right square symbols indicate X-Err-/X-Err+, and the

bottom and top symbols indicate Y-Err-/Y-Err+. If you obtain the information of

X-Y uncertainty from paper or other ways, you can directly fill in a fix value as X-Y

uncertainty with relative (%, in percent) or absolute mode. All of those setting can

be realized using “Errors” part at “Control Panel”. You can directly use mouse to

pull one of four red squares to obtain X-Y error. On the other hand you can apply

“Arrows4Errors” function at “Control Panel” to realize using cursor keys to move one

of four red squares to proper position. Now GDgraph provide a shortcut as “Ctrl+Alt”

to activated or deactivated “Arrows4Errors” function.

After setting the error of a data point, randomly select the next point using a mouse

or “PageDown” or “PageUp” key to select next or previous points to set error. When

the point is specified, there exist 4 red squares around it again, and you can pull error

bar in the same way as mentioned above. Repeat operations until you finish setting

11
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Figure 2.7 Window after reading the error information. Four squares around the data

point is assist user to digitizing it. And X-Y errors can be digitized in symmetry or

asymmetry mode.

Figure 2.8 Display actual digitization errorbar in Log with symmetry mode.

error for all the data. To exit error input mode, click the area out of data points. After

inputting errors, you will see a window as shown in Figure 2.7.

Update the software to allow to show the actual digitization error bar in Log data

type with symmetry mode, as shown in Figure 2.8.
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2.7 Modifying and removing the data

This section explains how to modify and remove the data.

(1) Modifying the position of data points, error bars, and axes

In order to modify a data, activate the data point by clicking it at first. Selected

point will appear 4 red squares. Then use a mouse or cursor keys to move it at a proper

position. If you want to modify the error bar, you can use a mouse to pull or cursor

keys to move one of four red squares to a proper position. For axes, use mouse to pull

the squares in the axes to a proper position.

(2) Removing data points and error bars

In order to remove a data point, activate the data point to remove. Then press

Right-click on the selected point, there will appear “delete” selection and the infor-

mation on the relative position with axes and the digitizing point X Y values, then

you can use “delete” to remove the selected point. If you want to remove or delete

whole data group, please select which group data you want to remove at first, then

click “Clear Group” button at “Control Panel” to realize it. To remove an error bar,

click and move the endpoint of the error bar to the center of point. In other hand, if

you want remove all errors, you can set 0.0 value at “Errors”.

2.8 Outputting the numerical data

When you finish reading data, select “Save Data File” from the “File” menu or

directly use “Ctrl+C” to copy all digitizing data to clipboard and paste to other ap-

plications. The output data is in exponent or float format, and the number of digit

can be set at “Settings” function in the “Edit” menu or “Control Panel”. Specify

file name in the file dialog in a new window. Each data can be set as 11 columns

to fit EXFOR format requirements. The output file contains the information of each

group No., number of data points, name of each column and digitizing data. Each

group data output contains X, Y, Y-Err+, Y-Err-, X-Err+, and X-Err- as shown in

Figure 2.9. And GDgraph provide another output order as “X, X-Err+, X-Err-, Y,

Y-Err+, Y-Err-” to fit different output requirements.

13



GDGraph 5.1 Manual

Figure 2.9 An example of outputting numerical data file. It contains 6 data column of

each data group, and the first two lines contains the group information and data type.
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Chapter 3

Advanced use of GDGraph

Some functions were implemented in GDGraph to read the numerical values more

easily and improve the quality of the digitized data.

• Import data function: Section 3.1.

• Project function: Section 3.2.

• Magnifying glass function: Section 3.3.

3.1 Import data function

This section explains the import data function. Import data function is a function

to load the numerical data from files and plot them directly on the image on the main

panel. The import data function enables us to reuse the data easily and check the data

accuracy in greater detail. On the other hand, you can compare other data group with

the digitizing image and data.

In order to use the import data function, please set and confirm axes at first, then

use “Import Data” function at the “File” menu.

How to load a data file is as following:

• The digitizing data is compared with the original image.

First of all, please pull the axis line to fit the image and set the axes values.

Otherwise, the import data will display unreasonable position or refuse to import

data. After setting axes, use “Import Data” from the “File” menu to load a data

file.

15
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Figure 3.1 Load a “Import data” file for comparison.

Figure 3.2 The procedure of imported data (1). Display the information of data file.

• There exist more than one group data in the main panel.

First of all, please check and confirm the axes setting as above also. Then, click

“New group” in “Control Panel” to create a new group No. for the import data.

After that, use “Import Data” from the “File” menu to load a data file.

The procedure of import data file is as following:

16
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Figure 3.3 The procedure of imported data (2). Set different labels for indicate the

symbol as different contents in the data file. These labels is optional setting.

Figure 3.4 The procedure of imported data (3). Choose or fill in a separator for each

partial contents, or fill the fixed column number for the actually importing contents.

• Pull axis lines and set the X-axis and Y-axis values as Section 2.4;

• Set a new group number for import data using “New Group” button at “Control

Panel”;

• Use “Import Data” from the “File” menu to open a data file as shown in Fig-

ure 3.1;

• After select a data file, GDGraph load data information at memory and show file

17
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Figure 3.5 The procedure of imported data (4). The first three lines contain the

“Data type”, “Title” and “Operate” for each column data. User can confirm and

modify above three lines information.

Figure 3.6 The procedure of imported data (5). To operate a whole column data using

a expression, and the calculation result is appear a new window.

information as Figure 3.2;

• Click “Next” button to continue importing data, there will appear a new window

as Figure 3.3. According to the detailed contents of data file and the habit

18



GDGraph 5.1 Manual

Figure 3.7 The procedure of imported data (6). Successfully import a group data

and compare with the digitizing data point and image. The method of operation the

import data point is the same as the digitizing one.

of users, three optional identifying control parameters can be set to represent

different contents and control labels by yourself. You also can omit one or all of

these three optional parameters, when the data file only contains numerical data.

These three optional parameters indicate as three labels such as “Text Label”,

“Title Label” and “Data Label”, respectively. The more detailed information on

three parameters is as following.

1) “Text Label”: It is start the contents of comments and memo until there

exist one of other two labels such as “Title Label” and “Data Label”. The

head of first line of this part have a red point at data content panel, if it is

used.

2) “Title Label”: It is the detailed contents or meaning of each column data,

which also indicate the user the contents of each data column. The head of

first line of this part have a yellow point at data content panel, if it is used.

3) “Data Label”: Actual data contents is listed after this label. The head of

first line of this part have a green point at data content panel, if it is used.

Note: You define a label as “Data Label” at this window, however in the
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actual data contents does not exist this “Data Label”, GDGraph will omit

“Data Label” and treat the contents as data after “Title Label”.

4) You can operate the imported information at data contents panel as add,

delete, modify, copy, paste, undo and redo etc.

• Click “Next” button to continue importing data, there will appear a new window

as Figure 3.4. According to the imported data format, you can choose one type

of separators to distinguish different partial contents, and you also can specialize

a separator by yourself. On the other hand, you can select partial contents from

whole data, and fill in the column range for each partial contents and separate

with comma such as “1-13,15-27,29-41” to represent X, Y, and Y error, which

column contents will be imported.

Note: “Column value” is help user to identify the column range, and use Left-

click key to obtain the column number information.

• Click “Finish” button to continue importing data, there will appear a new window

as Figure 3.5. There inform the total and current group number, and exist three

labels to represent as the beginning three lines such as “Data type”, “Title” and

“Operate”, respectively. You can operate and edit each column at this window.

More detailed information on the beginning three labels is as following.

1) “Data type”: It represent the data type as X, Y and their errors etc. You

can confirm, edit or reset a proper name of each column at this window.

GDGraph will accord this setting to reconstruct X, Y and their errors. And

you also can disable whole column data using “Discard” option.

2) “Title”: It is the same contents as its after “Title Label” at last window,

and can be manually modified and corrected by user.

3) “Operate”: It allows user to operate whole column data using a expression as

[c] = [b]∗0.05 or directly omit the active column as [b]∗0.05. It includes some

functions such as “cos(θ)”, “sin(θ)” etc. The detail of functions are included

in GDgrapg as list in Table 3.1. When you finished filling the expression,

then press keyboard “Enter”. A new window appear the calculation result

using the expression as shown in Figure 3.6. To click “Accept” button to

adopt the calculation result, otherwise the column data will keep the original
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one.

• Click “Finish” button to finish importing data procedure as shown in Figure 3.7.

You can import another group data in the same way as mentioned above. You also

can operate the import data and its errors at main panel as the digitizing data point.

Tips: How to import data quickly. If the data file contains numerical data only

with regular format using different column represent X, Y and X-Y error. You just

need to press the “Next” button to import the data.

Table 3.1 The operators and functions include in Import function

Operation Key

Operators +, -, *, /, **

Functions

abs([x]) absolute value of x

sqrt([x]) square root of x

log([x]) loge x, natural logarithm (base e) of x

exp([x]) ex, exponential function of x

sin([x]) sine of x, x in radian

cos([x]) cosine of x, x in radian

tan([x]) tangent of x, x in radian

deg2rad([x]) convert angle from degree to radian

rad2deg([x]) convert angle from radian to degree

asin([x]) inverse sine, sin−1(x)

acos([x]) inverse cosine, cos−1(x)

atan([x]) inverse tangent, tan−1(x)

sinh([x]) hyperbolic sine, sinhx

cosh([x]) hyperbolic cosine, coshx

tanh([x]) hyperbolic tangent, tanhx

(1) x: It denotes column No. such as A, B, C etc.

(2) Note: The expression have lower letter limitation.
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3.2 Project function

This section explains the project function. It is a function to save and load whole

information of digitization including original image, digitizing data, all settings, memo

information etc. The project function enables us to pause, stop, continue, review,

correct and modify the digitizing work at any time. So the digitizing work needn’t

to finish immediately or at the same time, and it is become easy and comfortable to

check, modify and correct digitizing results. This function is similar to “Import data

function”, but it needn’t to set some parameters and import data from file. You can

directly double click the project file icon, GDGraph will automatically open or load this

project file, and the whole information is the same as the original digitizing condition.

On the other hand, you also can open a old project file with “Open Project” in “File”

menu. If you want to stop or pause you digitizing job, it will restart in the future,

you can save the whole information as a project file using “Save Project” in “File”

menu. The extension file name of project file is default as “gdp”. You also can save

the project file with other extension name as you prefer.

3.3 Magnifying glass function

Using magnifying glass function, you can enlarge the figure partially. Select check

box “Zoom Window” at “Control Panel”, then the active point will be magnified at

a new window according to the parameters of “Settings”. In this window, enlarged

image is shown in Figure 3.8. You can move this window by dragging. It magnify

the local area of the image, and the window size can be set from 100% to 800%. The

data point in the magnifying glass window can be magnified 2 or 4 times, which all

of these parameters can be set at “Settings”. If you double click this window or un-

select “Zoom Window”, the magnifying glass window will disappear. If you want to fix

the magnifying window at one position and move the display image, you can use four

triangle symbols around the window to move the magnifying image area. It encourage

user to use a high-resolution image and high magnified times for digitizing, you can

use the four arrow symbol around the window to move the magnifying image area, if

the error bar is out of the magnifying window, and the active point is in this window.
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Figure 3.8 Window of magnify glass function. Magnify the partial image area, and

the size of this window and magnified times can be set at “Setting” function.

Warning: You can not directly modify the active data point in this window. This

window is only display the magnifying image. If you want to modify data point or

error, please use the method is described at Chapter 2.
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Chapter 4

Appendix

4.1 How to customize

This section explains how to customize GDGraph. Apply “Settings” in the “Edit”

menu or directly click “Settings” button at “Control Panel”, there will appear a new

window for setting some digitizing parameters, such as the shape, size, and color of

digitizing point, magnifying window size, magnified times of partial image, the cross

line length of error bar, the background of main panel with or without gridding line

and its distance, output data format as shown in Figure 4.1.

There display three group data point characters at “Settings” window. According

to your digitizing situation, you can change one of three group data point shape, color

and size. Double click the shape, color or size, which group data point character will

be setting, and appear a new window as Figure 4.2. You can select one of five kinds

symbol, and set the size and color of point. After setting, the setting results appear

at the main setting window. If you want to set different color for different group data,

you should click “Color” button, then select one of basic color or set the RGB value

by yourself.

You can set the size of magnifying window from 100% to 800%, and the magnified

times of partial image is from 200% to 400%. There have an option to select a back-

ground with or without gridding line and its distance. It is an assistant function for

comparing the digitizing axes or error bar line. The background with gridding line is

default.
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Figure 4.1 Window of “Setting” function. User can set the shape, size and color of

data point, output data format, magnifying window, magnified times etc.

Figure 4.2 Window of setting shape, color and size of data point.

4.2 Data format and Remark

You can set digitizing output data format using “Settings” in the “Edit” menu as

Figure 4.1. Each group data output contains 6 components in two option such as “X,

Y, Y-Err+, Y-Err-, X-Err+, X-Err-” and “X, X-Err+, X-Err-, Y, Y-Err+, Y-Err-”.

You can set output format as exponent or floating format and the number of digits is

as the example in “Setting” window by user. And you can select one of listed format
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or enter a new data format at combo box. For setting the output data format in

“Settings” window, there include two part contents of each setting, first part is to set

the output format of X, Y and their errors, and the second part is the output example

according to the format setting and sample data as shown in Figure 4.3. The sample

data can be fill by user.

Figure 4.3 Set the data format and output example.

GDGraph provide a “Remark function” for user to keep some memo text in digitiz-

ing process. You can use “Remark” in the “Edit” menu, “Remark” button at “Control

panel” or keyboard shortcut “Ctrl+K” to active remark function, and there will ap-

pear a new window for entering and editing what you want for memo as shown in

Figure 4.4. Then close this window when you finish typing to keep your comments
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Figure 4.4 Window of “Remark” function for filling some text of memo.

and memo. When you want to modify your remark, please use the same way as above

mentioned to open and edit it.
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4.3 Keyboard shortcuts

The correspondence between keyboard shortcuts and the buttons on the control

bar and menu in the menu bar is shown in Table 4.1. The shortcut key have not the

upper or lower letter limitation.

Operation Key

Create a new digitizing project Ctrl+N

Create a new digitizing project & reset Ctrl+R

Open a window to load a digitizing project Ctrl+O

Open a window to save a digitizing project Ctrl+S

Open a window to save a project as other name Ctrl+A

Open a window to load an image file & reset Ctrl+L

Open a window to load an image file Ctrl+G

Open a window to import a numerical data file Ctrl+I

Save the digitizing result as a numerical data file Shift+S

Paste an image to main panel or digitizing result to applications Ctrl+V

Copy the digitizing result to clipboard Ctrl+C

Start the setting function Ctrl+E

Make a memo for present digitizing work Ctrl+K

Activate or deactivate Axis Ctrl+X

Activate or deactivate Arrows4Errors Ctrl+Alt

Activate the next digitizing point PageDown

Activate the previous digitizing point PageUp

Arrows4Errors Activated

Symmetry condition

Increase X error ←

Decrease X error →

Increase Y error ↑

Decrease Y error ↓

Asymmetry condition

Increase/Decrease X-Err- error ← / →
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Increase/Decrease X-Err+ error Shift+→ / Shift+←

Increase/Decrease Y-Err- error Shift+↓ / Shift+↑

Increase/Decrease Y-Err+ error ↑ / ↓

29



GDGraph 5.1 Manual

4.4 ChangeLog

- Changes in Version 2.0 with respect to 1.0 (2006)

1. The graphics can be opened including mostly image format such as PNG,

GIF, BMP and JPEG etc.

2. The image can be zoom-in and zoom-out.

3. The image can be rotated, so the digitizing axes can fit well with the image

one.

4. The image size can automatically fit to the GUI main panel window.

5. Using a new button to revert image size as original one, when the image is

been zoom-in or zoom-out.

6. Allow to add and delete a data group. The maximum number of data group

is three and represent as blue, red and green color, respectively.

7. Allow to randomly add and move the digitizing point by a mouse.

8. Digitizing data can be saved as a data file or at clipboard and paste to other

applications.

9. Allow to digitize y error under asymmetry mode only using a mouse.

10. Allow to set fix value for y error using relative (%, in percent) or absolute

mode.

- Changes in Version 3.0 with respect to 2.0 (2011)

1. Allow to copy image directly from other application file such as MS Word,

PDF, etc.

2. Allow to select thin or thick line mode for axes, data symbol and error bar

etc.

3. Except for the image rotation function, there allow user to set a rotation

angle (in degree) to realize slight rotation.

4. Add magnifying glass function with fix window size and magnified times.

Partially zoom-in of the active point is available for checking and modifying

the position of digitizing point.

5. The digitizing axes and image can be zoom-in and zoom-out together.

6. Allow to move the digitizing point by cursor keys for slightly adjusting the

position.
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- Changes in Version 4.4 with respect to 3.0 (2012)

1. Digitizing X error is available, and allows to digitize X-Y error using cursor

keys.

2. Add Project and Remark function. The Project function allows to save

image, digitizing results, axes together with other settings for checking, cor-

rection, modification in the future. And the extension filename of project is

“rpp”. The Remark function allows to fill some marks and memo text for

checking, modification and memory.

3. Add Setting function, so change the color, size and shape of digitizing point

is available. The size of magnifying glass window is allowed to set. Allow to

change the partial image magnified times in the magnifying glass window

from 200% to 400% for obtaining more clear point image. Allow to change

the length of error bar cross line to clearly compare with the data point error

bar in image. A background with or without gridding lines is available, and

allows to set the distance of gridding line.

4. Allow to move magnifying glass window by mouse.

- Changes in Version 5.0 with respect to 4.4 (2013)

1. Language: Chinese → Chinese & English

2. GUI interface type: Dialogue → SDI (Single document interface).

3. Modify the function “Project” to reduce the project file size and memory

requirement. The extension filename is changed from “rpp” to “gdp”.

4. X, Y Error includes symmetry and asymmetry mode.

5. X, Y Error can set in absolute or relative value by user, respectively.

6. X, Y axes: Unit setting for X, Y data by user is available.

7. The import data function is available, and enable to reuse the former digi-

tizing data or compare with other data group easily.

8. Output data as X4 format is available as setting the output data format

using 11.xE or 11.xF . And user is allowed to set the number of digits of

output numerical data in “Settings” function.

9. To use shortcut key to select the active point by “PageUp” or “PageDown”

as previous or next point.
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10. Allow to change the X, Y error bar by cursor keys.

- Changes in Version 5.1 with respect to 5.0 (2016)

1. “New+Reset” function allows to start a new project and reset the original

setting condition.

2. Using “Load Image File Reset” function to realize load a new image and

reset the original software setting condition.

3. It is maintain the rotation angle setting, when the “RealSize” or “FitSize”

function in the navigation bar is used.

4. The default output format of uncertainties is changed from “X, Y, Y-Err+,

Y-Err-, X-Err-, X-Err+” to “X, X-Err+, X-Err-, Y, Y-Err+, Y-Err-”. And

there provide two options for output data order as “X, Y, Y-Err+, Y-Err-,

X-Err+, X-Err-” and the default one.

5. Zoom in the active axis point with magnify glass function is available. Zoom

window is still focus on the active axis point, when the magnify glass function

is used.

6. A shortcut “Ctrl+X” could be used to activate or deactivate axis point as

one by one.

7. Add a “Axis Color” function, which allows to select the axis line color.

8. “Tab” key could be used to assist XY axis value setting.

9. Using “Ctrl+Alt” to activate or deactivate “Arrows4Errors” function.

10. Update the software to allow to show the actual digitization error bar in

Log data type with symmetry mode.
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